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Why Vivado Design Suite?

Larger FPGAs lead to more difficult design issues
o Users integrating more functionality into the FPGA

o Use of multiple hard logic objects (block RAMs, GTs, DSP slices, and microprocessors, for
example)

> |/0 and clock planning critical to FPGA performance
o Higher routing and utilization density
> Complex timing constraints with designs that have multiple clock domains

FPGA designs are now looking like ASIC platform designs
> Assembled from IP cores—commercial or developed in-house

> Maintaining place and route solutions is very important (this is resolved with the use of
partitions)

° Bottom-up design methodology
> Team design flows becoming a necessity

Vivado Design Suite i rovides solution to all of the above



Vivado IDE Solution
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Interactive design and analysis
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Embedded System Design — Vivado Flow
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Typical vs Vivado Design Flow

System Planning and
HDL Design
RTL Synthesis

Netlist Linking and
Constraints

Packing, Placement,
Optimization

Routing, Post-Route
Optimization

Static Timing
Analysis

DRC and Bitstream
Generation




Vivado Flow
Practical Steps




Creating a Project in Vivado

File Flow Tools Window Help Q- Quick Access

VIVADO!

HLx Editions

.
Quick Start ’

Create a New Vivado Project

’
Create Project :’k. VlVﬁE{Q This wizard will guide you through the creation of a new
Open Project > project.
Open Example Project > To create aVivado project you will need to provide a

name and a location for your project files. MNext, you will
specify the type of flow you'll be working with. Finally,
you will specify your project sources and choose a
default part.
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Finish Cancel




Creating a Project in Vivado

Project Name

Enter a name for your project and specify a directory where the project data ’
files will be stored.

Project name: lab_hello_world

=
ew Frojec

+| Create project subdirectory

Project Type
Project will be created at: /projects/lab_hello_world Specify the type of project to create. ‘

@

Einish Cancel e RTLProject

You will be able to add sources, create block designs in IP Integrator,
generate IP, run RTL analysis, synthesis, implementation, design planning
and analysis.

Do not specify sources at this time

Post-synthesis Project: You will be able to add sources, view device
resources, run design analysis, planning and implementation.

@ < Back Finish Cancel




Creating a Project in Vivado

Add Sources

Specify HOL, netlist, Block Design, and IP files, or directories containing ’
those files, to add to your project. Create a new source file on disk and add

MNew Project

+ Add Constraints (optional)

F |
Specify or create constraint files for physical and timing constraints. ’

Use Add Files, Add Directories or Create File buttons below

Add Files Add Directories Create File +‘
Scan and add RTL include files into project
¥ | Copy sources into project
| Add sources from subdirectories Use Add Files or Create File buttons below
Target language: | WHOL w Simulator language: | Mixed W

Add Files Create File

©)

inish Cancel

¥| Copy constraints files into project

Cancel




Creating a Project in Vivado

New Project

Default Part

Choose a default Xilink part or board for your project. This can be changed later. ‘

Boards

Vendor: | All w | Mame: | All + | Board Rew:  Late:
Search: O~ ~
Display Name Preview Vendor F

ZedBoard Zynqg Evaluation and Development Kit
Add Daughter Card Connections

em.avnet.com

N

Add Daughter Card Connections

¥ilinx. com




v PROJECT MANAGER
£ Settings
Add Sources
Language Templates

¥ IP Catalog

IP INTEGRATOR
Create Block Design
Open Block Design

Generate Block Design

SIMULATION

Run Simulation

RTL ANALYSIS
> Open Elaborated Design

SYNTHESIS
P Run Synthesis

n Synthesized Design

IMPLEMENTATION

P Run Implementation

> Open Implemented Design

PROGRAM AND DEBUG

i Generate Bitstream

> Open Hardware Manae

Flow Navigator

Vivado
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PROJECT MANAGER - lab_hello_world

Sources
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Design Sources

Constraints

Simulation Sources
sim_1

Hierarchy Libraries Compile Order

Properties

Select an object to see properties

Project Manager @

Tcl Console
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Messages |Log

Status
Not started
Not started

Constraints
constrs_1
constrs_1

Reports

Menu Bar @
Vain | oolbar @

Project Status Bar

Ready

2= Default Layout

Project Summary

Settings Edit

Project name:
Project location:
Product family:
Project part:

Top module name:
Target language:

Board Part

Display name:
Board part name:
Connectors:
Repository path:
URL:

Board overview:
Changes

Simulator language:

lab_hello_world
/projects/lab_hello_world
Zynq-7000

ZedBoard Zynq Evaluation and Development Kit (xc7z020clg484-1)
Not defined
VHDL

Mixed

Workspace €)

ZedBoard Zynq Evaluation and Development Kit
em.avnet.com:zed:part0:1.4

No connections
(opt/Xilinx/Vivado/2018.2/data/boards/board _files
http://www.zedboard.org

ZedBoard Zynq Evaluation and Development Kit

Design Runs  x

%
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Message & Results @

Elapsed

Run Strategy
Vivado Synthesis Defaults (Vivado
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Project Navigator Main Components

. Menu Bar: Vivado IDE commands
. Main Toolbar: Access to the most commonly used Vivado IDE commands

Workspace: area for schematic panel, device panel, package panel, text editor panel.

. Project Status Bar: displays the status of the currently active design
. Flow Navigator: provide easy access to the tools and commands necessary to guide the

design from start to finish.

. Project Manager Pane: by default displays information related to design data and sources,

such as Property Window, Netlist Window, and Source Window

. Project Status Bar: displays information about menu bar and toolbar commands; task

progresses

. Results Window Area: there are a set of windows, such as Messages, showing message

for each process, Tcl Console, Tcl commands of each activity, Reports, reports generated
throughout the design flow, Desing Runs, display the different run for the current project

ICTP 12




Create a Block design

lab_hello_world - [/projects/lab_hello_world/lab_hello_world.xpr] - Vivado 2018.2.1

File Edit Flow Tools Reports Window Layout Wiew  Help Q- Quick Access
=, - P, o X

F |

FELTRTEGETGT AR PROJECT MANAGER - lab_hello_world

v PROJECT MANAGER )
Sources ?_0O0 X Project Summary
£F settings
Q T =2 4+ g ®
FN - .
Add Sources Settings Edit
Design Sources
Language Templates 5 Constraints Project name: lab_hello_world
¥ IP Catalog w Simulation Sources Project location: {projects/lab_hello_waorld
sim_1 Product family: Zyng-7000 _
v IP INTEGRATOR Project part: ZedBoard Zyn| Create Block Design
Create Block Desiqnh’ T TELAE TETE LT O Please specify name of block design.
Open Block Design Target language: WHDL ‘
il EEEEEEEEEEEEELEEEEEEEEEEEEEEEREEE Simulator language: Mixed
Generate Block Design Hierarchy Libraries 4 » =
Cesign name: lab_hw
Directorny: s =Llocal to Project= w
Specify source set: Design Sources w

@ “ Cancel




Adding IP Modules to the Design Canvas

BLOCK DESIGN - lab_hw

So x DesigSigngaBoa | ? _ O Diagram
LW

Q E % + 0 'l:l' o w :]:5] 'E:}
w Design Sources (1)
1 Jab_hw (lab_hw.bd)] Add IP (Ctrl+1)
» Constraints
Diagram 00X
x>

w Simulation Sources (1)
"F "
prall - S +

5 sim_1 (1)

Hierarchy IP Sources Librd4 » =

This design is empty. Press the < button to add IP.

Source File Prope

&
Search: Q- zy [} (1 match)

¥ Enabled . I ZYNQ7T Processing System

lab_hw.bd

1
General Properties TH

EMTER to select, ESC to cancel, Ctri+Q for IP details




Adding More |Ps

Diagram x Address Editor x
@ a & O Q +

» Designer Assistance available. Run Block Automation

Search: | O~ gpio (1 match)
IF AXl GPIO

EMTER to select, ESC to cancel, Ctrl+Q for IP details

& » C
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Diagram x Address Editor x 00
@ @ ¥ W © Q + ¥ » C o 7
* Designer Assistance available. Run Block Automation Run Connection Automation
axi_gpio_0 -
A4 5ax
s_axi_ack crio ||

5_axi_aresetn

AXl GPIO

processing_systemn7_0

oor 4|
- FixED_1I0 ]|
= M_AXI_GPO_ACLK ZYNG H_:L;'EL'EG:EK:- i
FCLK_RESETO_N

ZiNQT Processing System




PS Customization Options

Page Navigator Zynq Block Design Summary Report
Zynq Block Design
Yo g ___—
It0 Peripherals General
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SPI 1
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o UART 1 A
Clock Configuration MUX GPIO ; GIC Snoop Contral unit AL
(M1 s0a O MAE r Slave
- SD 1 = 512 KB L2 Cache and Contraller Ports
) . e Channel
CDR Configuration USE 0 ) .
UsSBE 1 - OCM ZéEﬁK:
__ . CoreSight Interconnect
SMC Timing Calculation ENETO —r
9 ENET 1 Central Cormponsi 3
Bank1 Intercannect .
MIO FLASH Memary -+
Interrupts (53:16) Imeriaces o . oab 1
B §|E::” 107 & Memory Interfaces
NAND -~ d
QUAD SF A | GEVIC Programmable #| DDR2/3,LFDDRAZ
T—— i Logi to Memary ) Cantraoller
SMC Timing Interconnect »
Calculation 1 F T
DMAEY N Z[13[14]15
4 (9 [1da(11
) CRES 4 s [ |7 Processing System(PS
Resats | Generation | R ng sy (PS5)
lofaf 2af EIENEIE] DMA IRC High Performarmce
xtended 32b GP 32b GP | rhannels Config XaDC
Clock Parts Master Slave SHA Ports
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PS-PL Configuration Options

ZYNQ7 Processing System (5.5) /!

@) Documentation £F Presets IP Location ¥ Import XPS Settings

Page Navigator P5-PL Configuration Summary Report

Zynq Block Design - Q = =

PS-PL Configuration Search: O~

) ) Mame Select Description
Peripheral I/0 Pins
» General
MID Configuration ~  AX| Non Secure Enablement 0 ~ | Enable AX¥| Non Secure Transaction

w  (GP Master AXl Interface

Clock Configuration
> M AX] GPO interface ¥ Enables General purpose AXl master interface 0

DDOR Configuration » M AXI GPL interface Enables General purpose AXl master interface 1

»  GP Slave AXl Interface
SMC Timing Caleulati > HP Slave AXl Interface
»  ACP Slave &X¥ Interface
> DMA Controller

» PS-PL Cross Trigger interface Enables PL cross trigger signals to PS and vice-versa

Interrupts

| (0] 4 | ‘ Cancel |




MIO and EMIO Configuration

: Re-customize IP

ZYNQ7 Processing System (5.5) |

€ Documentation £F Presets IP Location &F Import XPS Settings

Page Navigator Peripheral IO Pins Summary Report

Zyng Block Design « Qg = =2 @
PS-PL Configuration  Search: | O~

Peripheral If0 Pins

MIO Confi . Peripherals 34 35 36 37 38 39 40 41 42 43| 44 45|45 47| 43 45|50 S1 52 53 EMIO
onfiguration
9 > | | UART O ~
UARTO UARTO UARTO UARTO UARTO EMIO
Clock Confi ti ¥ UART 1
ock Configuration 5
9 UARTL UARTL UARTL UARTL UART1  EMIO
fi : [2C 0
DDR Configuration 12C0 12C0 12C0 12C0 Jelody] EMIO
o/ 1201 12C1 12C1 12C1 12C1 12C1 EMIO
SMC Timing Calculati
b
CAN D CAMO CAMO CAMO CAMO CAMO EMIO
Interrupts
b CAM 1
CAML CAML CAML CAML CAML EMIO
TTeo TTCO EMIO
TTC1 < E

| oK | | Cancel |




Running Block Automation

Diagram x Address Editor x 00

@ a &KX = O Q ¥ #» C U9

¥ Designer Assistance availabl@ Run Block Automation

»

Run Block Automation

Automatically make connections in your design by checking the boxes of the blocks to connect. Select a block on the

B prncegglng_s—.yatem?_ﬂ . left to display its configuration options on the right.
DOR + |||
Ql =z 2
- FIXED_IO + " ~ ¥ Description
—| M_AXI_GPO_ACLK ZYNO M_AXI_GPO + i:: v Al Automatmr! (1 out of 1 selected) This option sets the board preset on the Processing System. All
- FOLE CLED ¥ ¥ processing_system?_0 current properties will be overwritten by the board preset. This action
- cannot be undone. Zyng7 block automation applies current board
FCLK_RESETO_N o= preset and generates external connections for FIXED 10, Trigger and
L ) DCR interfaces.
ZYNQ7 Processing System MNOTE: Apply Ecard Preset will discard existing IP configuration - please

uncheck this baox, if you wish to retain previous configuration.

Instance: /processing_system?_0

Options
Make Interface External: FIXED |10, DDR
Apply Board Preset: O
Cross Trigger In: Disable w
Cross Trigger Out: Disable  w

® [




Run Connection Automation

Diagram x Address Editor x

@ a KX &L O Q

00

 # C 9 & o

Fun Connection Autam:;iltinﬂ

» Designer Assistance available.

axi_quad_spi_0

o4 AXLLITE

SR
ext_spi_clk - +“
_ sTARTUP_ID + |||
s _axi_aclk o )
ipZintc_irpt

5_axi_aresatn

AXl Quad 5Pl
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Block Memory Generator
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AXl BRAM Controller
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Connecting IPs — Making Connections With the Tool

Run Connection Automation

Automatically make connections in your design by checking the boxes of the interfaces to connect, Select an
interface on the left to display its configuration options on the right.

Q = £
— —
. -

w | All Automation (5 out of 5 selec

Description

Connect Slave interface (faxi_quad spi 0fAX LITE) to a selected

wo | AF axi_bram_ctrl_0 Master address space.
+ | {I BRAM_PORTA
/| {} BRAM _PORTE Options
|} 5_AXI
~ ¥ TF axi_quad spi 0 Master fprocessing_system? 0/l
20
7 0 SPLO Bridge IP Mew AXl Interconnect

Clock source for driving Interconnect IP | Auto
Clock source for Master interface Auto

Clock source for Slave interface Auto

@ “ Cancel




Connecting IPs — Making Connections With the Tool
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Connecting IPs — Making Connections Manually

J:—“mﬂjﬁlﬂl x]ﬂ.ﬂ.ddressEditnr }e:] O ™ =
+[| % design_1
Qg E Designer Assistance available, Fun Blodk Automation Run Connection Automation
Qg -

g axi_quad_spi_0
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Ly e spi ck sPLo-4]|
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| =i
= AXI Quad 5PI
{3 axi_bram_ctrl 0 FOcessing_systemZ_U
Found 4 ports oo
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Options for External Connections

axi_gpio_0

GPIG L
(s _axT GRIOZ=
_axi_ack  gpiol_io f31:04
_a_aresem  ggio2_io_af3 L0
ggin2_ia_t31:00e

Axl GRIO

A1 Quad SPI

Block Interface: GPIOZ

S, Search...
L Select Al

[#  Block Interface Prope@es. ..

Ctrl+E

]
Delete
Ctrl+C
Ctrl+V
Ctrl+F
Ctrl+4

[@ Run Connection Automation...

i IP Settings...

¥ Vvalidate Design F&
Start Connection Mode Ctrl+H
Make Connection...

Mierarract Bir

Disconnect Pin Inside Hierarchy

i_gpio_0/gpiod_ioc o] [dq
-to 0 gpicd_io o'

Expand,/Collapse

Create Hierarchy. ..

. ﬂ} Create Port

Create port and connect it to selected pins and ports

to

o

Port name: | gpio2_io_o
Direction: Qutput -
Type: Other ﬂ\s -
Create vector: Clock

Feset

I| Freguency (MHz): [Interrupt

Data

Interrupt type: Clock Enable

Sensitivity:

Connect to 'gpio2_jio_o' selected pin

Edge

Active Low

|| concl |




DRC (Desing Rule Check) Design Validation

% Address Editor

Diagram :-c
@ Q ¢ & © Q s + H A C 9 T
st 57 0_50M Walidate Design (F&)
ps7_0_axi_periph
Sowest_sync_clic mii_reset " N
ext_reset in bus_struct_reset{d:d] —E' + so00 s

DUE_MESet_in penpheral nesetfd:d] ALK
mi_debug_sys_rst  nberconnect tn{d:a] BAESETH i B tr 0
a¥l_brarm_{

dom_ocked penpheral anesetnfd:a) H10_ACLE | ol | . — e

- X MO0 Ax] 4 =
s00_sresETy l—H - B ;i
Processor Systern Reset e .X. W1 A1 4 i) Vil 5 A BRaM_FOATA + [[|=

- 5 i achk -

aram POATE + [|=

5 o l_aresein

L _ORESETH AX] BRAM Controlier

MKI_AAESETH
‘ -F MO1_ACLE

Validation successful. There are no errors or critical warnings in this design.




DRC — Design Validation

Jgaohgram X | B Address Editor X | O X
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FIXED 104x {> FIXED_I0
! USSIND Ok
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Validate Design (F6)
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Gr NQ7 Processing System
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Address Map

«  Address Editor %

Diagram
Q = £
Cell Slave Interface Base Name

w 1F processing_system7 0
~ B Data (32 address bits : Ox40000000 [1G ])

=o axi_quad_spi_0 AXl LITE
== axi_bram_ctrl 0 5 _ax

Reqg
Memo

Offset Address

Ox41EQC_ 0000
0x4000_0000

Range

G4k
=18

w

w

High Address

Ox41ED_FFFF
Ox4000_1FFF




Generating Output Products

BLOCK DESIGN - lab_hw *

S50 x DesigSignaBoa| ? 0O O Diagram x Address Editor x
Q = 5 + @ Q 3 X ¢ Q
The following output products will be generated.
v @ Design Sources (1) Source Node Properties... Ctri+E /
= lab_hw (lab_hw.bd) e Open File Aft+0
» Constraints Preview
e Simulation Sources (1) Create HDL Wrapper... Q = =
y sim_1 (1) View Instantiation Template « /8 lab_hw.bd (00C per IP)
ﬁenerate Output Products... O synthesis
i Implementation
_____________________________ Reset Cutput Products... 4 simulation
Hierarchy |F Sources L

Synthesis Options
Global
® Qut of context per IP

Out of context per Block Design

Run Settings

*) On local host: Mumber of jobs: | 8 w
On remote hosts Configure Hosts
Use LSF: Configure LSF

® e |




Creating an HDL Wrapper

BLOCK DESIGN - lab_hw

Sourc x Design | Signals | Board 2 _00 Diagram x Address Editor x

Qa z = 4+ 0 el @ a % ® o q
™ Design Sources (1) Source Mode Properties... Ctri+E
W e [H] Iab_hw “Eb_hWbd} (1) = Open File Alt+0

> @ lab_hw(STRUCTURE] { mib_reset
5 Constraints Create HDL Wrapper... :_,_,,::,::
V Simulation Sources (1) View Instantiation Template I -]

B sim 1 (1) Generate Output Products...

Reset Output Products...




Project Data and Directories

All project data is stored in a project name directory containing the
following directories

o project_name.xpr file: Object that is selected to open a project (Vivado IDE
project file)

o project_name.runs directory: Contains all run data

o project_name.srcs directory: Contains all imported local HDL source files,
netlists, and XDC files

o project_name.data directory: Stores floorplan and netlist data




Journal and Log Files

Journal file (vivado.jou)
o Contains just the Tcl commands executed by the Vivado IDE

Log file (vivado.log)

o Contains all messages produced by the Vivado IDE, including Tcl commands and results,
info, warning, error messages, etc.

Location
° Linux: directory where the Vivado IDE is invoked

o Windows via icon: APPDATA%\Xilinx\Vivado or
C:\Users\<user_name>\AppData\Roaming\Xilinx\Vivado

> Windows via command line: directory where the Vivado IDE is invoked
° From the GUI

o Select File > Open Log File
o Select File > Open Journal File




Vivado Visualization Features

Visualize and debug a design at any flow stage
> Cross-probing between netlist/schematic/RTL

Fix Instances I
# Highligh 3

& Mark Cark-M

iFy (ME
12,4731
Cross-probe 1o FPGA Editor

4 Schematic &
Showr Connect it o Car+T

—_— G0 To Instantiation Fr

i Show Hierare by 33
Select




Gain Faster Timing Closure

o Analyze multiple implementation results
o Highlight failing timing paths from post-route timing
o Quickly identify and constrain critical logic path

oConnectivity display
o 1/0s, net bundles, clock domains

oHierarchical floorplanning
o Guide place & route toward better results

oUtilization estimates
o All resource types shown for each Pblock

o Clocks or carry chains




Tool Command Line (.tcl) Features

*** Tcl Console enables the designer to actively query the design netlist

¢ Full Tcl scripting support in two design flows
*** Project-based design flow provides easy project management by the Vivado IDE
** Non-project batch design flow enables entire flow to be executed in memory

*»* Journal and log files can be used for script construction




Vivado Design Suite
Elaboration Process




Embedded System Design — Vivado Flow

Implementation

Timing
Verification




Elaboration

o Elaboration is the RTL optimization to an FPGA technology

o Vivado IDE allows designers to import and manage RTL sources
o Verilog, System Verilog, VHDL, NGC, or testbenches

o Create and modify sources with the RTL Editor
o Cross-selection between all the views

o Sources view
o Hierarchy view: Display the modules in the design by hierarchy

o Libraries view: Display sources by category




Vivado Design Suite
Synthesis Process




Embedded System Design — Vivado Flow

Optional

Implementation

Timing
Verification




Vivado IDE Synthesis

o Applicable only for RTL (HDL) design flows
o EDIF is black boxed and linked after synthesis
o Synthesis tool uses XDC constraints to drive synthesis optimization

o Design must first be synthesized without timing constraints for constraints editor usage

o XDC file must exist

o Synthesis settings provide access to additional options




Logic Optimization and Mapping to Device Primitives

Synthesis of an RTL design not only optimizes the gate-level design
but also maps the netlist to Xilinx primitives (sometimes called
technology mapping)

L Project Summary % | @ Device x ] Schematic x Oa X
| | J \

-;[] nces 18 1JO Ports 489 Nets

-

-

o .

o char_fifo_i0

W

g din[7:0]

] rd_clk dout{7:0]

'_Q* rd_en empty E
= ret full

'i wr_clk

| Wr_en

; char_fifo

&

[T




Synthesized Design

Accessed through the Flow Navigator by selecting Open Synthesized Design

Representation of the design after synthesis
> Interconnected netlist of hierarchical and basic elements (BELs)
o> Instances of modules/entities

° Basic elements
o LUTSs, flip-flops, carry chain elements, wide MUXes
> Block RAMs, DSP cells
> Clocking elements (BUFG, BUFR, MMCM, ...)
o 1/O elements (IBUF, OBUF, I/0O flip-flops)

Object names are the same as names in the elaborated netlist when possible




Vivado Design Suite
Implementacion Process




Embedded System Design — Vivado Flow

Optional

Implementation

Timing
Verification




Vivado Implementation Sub-Processes

Vivado Design Suite Implementation process transform a logical netlist
(generated by the synthesis tool) into a placed and routed design ready for
bitstream generation

* Opt design
* Optimizes the logical design to make it easier to fit onto the target FPGA

* Place design
« Places the design onto the FPGA's logic cells

 Route design
* Routing of connections between the FPGA's cells




Using Design Constraints for Guiding Implementation

There are two types of design constraints, physical constraints and
timing constraints.

Physical Constraints: define a relationship between logic design objects and device resources
* Package pin placement

* Absolute or relative placement of cells:
 Block RAM
e DSP
* LUTs
* Filp-Flops
* Floorplanning constraints that assign cells to general regions of an FPGA

Timing Constraints: define the frequency requirements for the design. Without
timing constraints, Vivado Design Suite optimizes the design solely for wire length and
routing congestion and makes no effort to asses or improve design performance

Vivado ICTP




After Implementation

o Sources and Netlist tabs do not change

. . . 4 Implementation
o Now as each resources is selected, it will show & Implementation Settings
the exact placement of the resource on the die > Run Implementation
o Timing results have to be generated with the # Bl Implemented Design
Report Timing Summary £4 Edit Timing Constraints
@ Report Timing Summary
o As each path is selected, the placement of the I, Report Clock Networks
logic and its connections is shown in the Device %] Report Clock Interaction
view &) Report DRC
- . i+ Report Noise
o This is the cross-probing feature that helps Report Utilization

with static timing analysis &) Report Power




Implementation Out-of-Date Message

Au_u

| Q- Search commands

Synthesis and Implementation Out-of-date more info

- — T = oo

| Q~ Search commands

synthesis and Implementation Out-of-date more info

Synthesis and Implementation Out-of-date Due to  Force up-to-date ¢ %

1 (@) synth_& - Files Modified:
@ design 1 wrapper.v (E:\Projects_FPGA'R_Gonzalez\project_ud-copro-mix_200mhz\project_ud-co}——

1 (@ impl_g - Files Modified:
&8 design 1 wrapper.v (E:\Projects_FPGA'R_Gonzalez\project_ud-copro-mix_200mhz'\project_ud-cof

I |

|




Software Development
Kit (SDK)




Embedded System Design — Vivado-SDK Flow

Implementation

Timing
Verification

Software Development Kit



Embedded System Design — Vivado-SDK Flow

VIVADO'

Software Development Kit

Open VIVADO
Create New Project

Create New Block Design

Add PS7
Configure PS7
Run Block Automation
Add and Configure other IPs
Run Connection Automation
Validate Design

Create HDL Wrapper
Generate Output Files
Generate Bitstream

Export Hardware to SDK

Create Board Support Package
Create New ‘C’ Application
Write ‘C’ Code
Build the Application

Configure FPGA

Run on Hardware (Debug)




Embedded System Tools: Software

Eclipse IDE-based Software Development Kit (SDK)
c Board support package creation : LibGen

> GNU software development tools

o C/C++ compiler for the ARM Cortex-A9 processor (gcc)

> Debugger for the ARM Cortex-A9 processor (gdb)

Board support packages (BSPs)

o Stand-alone BSP
o Free basic device drivers and utilities from Xilinx
o NOT an RTOS




SDK Workbench Views

C/C++ project outline displays the
elements of a project with file
decorators (icons) for easy
identification

C/C++ editor for integrated software
creation

Code outline displays elements of the
software file under development with
file decorators (icons) for easy
identification

Problems, Console, Properties views

list output information associated with

the software development flow

Vivado

=
il ©

{25 Project Explorer & |

lab_gpio_in_out.sdk - C/C++ - lab_gpio_inout_sdk/lab_gpio_in_out.c - Xilinx SDK

B ¥ ©
> (& lab_gpio_in_out_wrapper_hw_

> #¥ Binaries

» il Includes G

» = Debug

> = src

v ie lab_gpio_in_out.c
u xgpio.h
u xgpiops.h
u xparameters.h
& iPinNumber : int
& psGpiolnstancePtr : XGpioP:
+® main(void):int

> (il lab_gpio_inout_sdk_bsp

44 Target Connection &2 = O

» = Hardware Server
> = Linux TCF Agent
> = QEMU TcfGdbClient

® v ‘i ¥ @mg x

‘ | system.hdf

= =
®// Advanced Workshop on FPGA-based Systems-on-Chip for

|, system.mss l¢ lab_gpio_in_out.c 2

#include "xparameters.h"
#include "xgpio.h"
#include "xgpiops.h"

static XGpioPs psGpioInstancePtr;
static int iPinNumber = 7; /*Led LD9 is connected to MIO

© ~int main (void)

{ @
XGpio sw, led;

int i, pshb_check, sw_check;
//static XGpio GPIOInstance Ptr;
XGpioPs_Config*GpioConfigPtr;
int xStatus;

int iPinNumberEMIO = 54;

u32 uPinDirectionEMIO = 0x0;

u32 uPinDirection = 0x1; =
xil_printf("-- Start of the Program --\r\n"); =
»
I*] Problem I Tasks | & Console 2 [ Properti & Terminal <
S v(g BB MmB-Q-
CDT Build Console [lab_gpio_inout_sdk]
Invoking: ARM v7 Print Size 2
arm-none-eabi-size lab_gpio_inout_sdk.elf |tee "lab_gpio_inou®
text data bss dec hex filename
30716 1192 22616 54524 dafc lab_gpio_inout_sdk.elf

Finished building: lab_gpio_inout_sdk.elf.size e

15:53:03 Build Finished (took 1s.771ms) >

D 2PDE S 0

§ v
5 (@)%
g=ouR @mMa = B
BB R o ¥
-
2 xparameters.h
U xgpio.h
2 xgpiops.h

@ ° psGpiolnstancePtr : X¢
@ SiPinNumber: int

a®

main(void) : int

Bsx| = [ul
15:50:22 INFO : Reg
15:50:22 INFO : Lay
15:50:22 INFO 1 XS(
15:50:22 INFO : Sud
15:50:22 INFO : Su¢
15:50:22 INFO ¢ Prq
15:50:22 INFO : Che




Software Management Settings

Software is managed in three
H Settings . i
major areas “ =) g

-

* Resource )
Builders Configuration: | Debug [ Active] = | | Manage Configurations... |
v C/C++Build
Build Variables
Environment ® Tool Settings | M Devices | # Build Steps Build Artifact Binary Parsers *

Logging
Settings
Tool Chain Editor
P C/C++ General
Project References

o Compiler/Linker Options
o Application program >

v 3 ARM V7 gcc assembler Command: |arm-none-eabi-gcc
2 General
v & ARM v7 gcc compiler
& symbols
& warnings
& Optimization
2 Debugging
2 Profiling
2 Directories
# Miscellaneous
¥ (& Inferred Options
(2 software Platform
# Processor Options
v & ARM v7 gec linker

All options:

Run/Debug Settings

Expert settings:

Command
line pattern:

| ${COMMAND} ¢ ${FLAGS} ${OUTPUT |

Vivado



Software Management Settings

Software is managed in three
major areas

Board Support Package Settings

Board Support Package Settings

Control various settings of your Board Support Package.

lab_gpio_inout_sdk_bsp

standalone
. OSType:  standalone
¥ drivers p—
ps7_cortexad 0 |6'Tl|r |

OSs Version:

o Software Platform Settings Target Hardware

.

standalone is a simple, low-level software layer. It provides
access to basic processor Features such as caches, interrupts
and exceptions as well as the basic Features of a hosted
environment, such as standard input and output, profiling,
abort and exit.

Hardware Specification: fcris_projectsfictp_labs/lab3/lab_gpio_in_out/lab_gpio_in_out.sdk/lab

> Processor: s?_cortexag-_()
> Board support package ,,

Supported Libraries

Check the box next to the libraries you want included in your Board Support Package.You can
configure the library in the navigator on the left.

Description

Name Version
libmetal 1.4
lwip202 1.1
openamp 1.5
i wilFFe iza

Libmetal Library
lwip202 library: lwiP (light weight IP) is an open source TCP/I
OpenAmp Library

i Cenarir Fak Fila Suckam 1 ihrar

| Cancel | [GiOK




Software Management Settings

Software is managed in three

major areas Generate a linker script
Generate linker script i G
e, +
Control your application's memory map. 5
(]
Output settings Basic | Advanced
Project: lab_gpio_inout sdk
Output Script: Place Code Sections in: |ps7_ddr_0 =
[1_0ut.sdk,’labjpia_incut_sdk,’srcflscript.ld” | Browse | Place Data Sectionsin: |ps7 ddr 0 |
Modify project build settings as Follows: Place Heap and Stack in: | ps7_ddr 0 |~
S SOftwa e Plathrm SEttlngS | Set generated script on all project build configurat = | Heap Size: |‘1 KB |
o Board support package » HardwareMemory Map Stack Size: [1KB |
Memory Base Address Size
ps7_ddr 0 | 0x00100000 | 511 MB
ps7_ram_0 | 0x00000000 | 192KB
ps7 ram 1 | OXFFFFO000 | ~63.5KB

b Fixerd Sertinn Assinnments

@ | Cancel | ([ Generate |

Vivado




Integrated Xilinx Tools in the SDK

Xilinx additions to the Eclipse IDE
o BSP Settings
o Software Repositories
o Generate Linker Script

° Program the programmable logic
o Bitstream must be available

o Create Zyng Boot Image

> Program Flash Memory

o Launch XMD Console

o Launch Shell

o Configure JTAG Settings

> SysGen Co-Debug Settings

Run Xilinx Window Help

Generate linker script
Board Support Package Settings
Repositories

Program FPGA
Dump/Restore Data File
Program Flash

Launch Shell

XSCT Console

Configure QEMU Settings
Create BootImage
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Vivado Design Suite
Basic Static Timing Constraints




Basic Timing Constraints

There are three basic timing constraints applicable to a sequential
machine
> Period
o Paths between synchronous elements clocked by the reference clock net
> Synchronous elements include flip-flops, latches, synchronous RAM, and DSP slices
° Use create clock to create the constraint
° Input Delay
o Paths between input pin and synchronous elements
> Use set input delay to create the constraint
o Qutput delay
o Paths between synchronous elements and output pin
° Use set output delay to create the constraint




Timing Paths Example

FPGA DEVICE

. -------------------------------------------------------
1
Board ! Board
. i Internal Delay Data Path Delay na'
Device E REGA Device
0 a

Board Clock




Creating Basic Timing Constraints in Vivado IDE

1. Run Synthesis (2 Synthes
. . thesis Settings
2. Open the synthesized design fiﬂ:w;f g
. . 4 thesized Design
3. Invoke constraints editor

f4 Edit Timing Constraints

i& Set Up Debug
@ Report Timing Summary

;. Report Clock Networks
& Report Clock Interaction

D Report DRC

@ Feport Moise
Report Utilization
%I;’ Feport Power
{_}FD Schematic




Clock Constraint Setting

i - S 1
ﬂ_, Timing Constraints Wizard u
| B —— il —
Primary Clocks
Primary clocks usually enter the design though input ports, Specify the period and optionally a name ‘
and waveform (rising and falling edge times) to describe the duty cyde if not 50%:. More info '.S) I e | 53 |
Recommended Constraints Primary Clocks
_ ] ) ] ) Primary clocks usually enter the design though input ports. Specify the period and optionally a name
N Object  Mame Frequency (MHz)  Period (ns) Rise At{ns)  Fall At(ns)  Jitter (ns) and waveform (rising and faling edge times) to describe the duty cyde if not 50%. More info ‘

e ] endefined [ undefied [T

Recommended Constraj
ﬂ_, Primary Clock Constraints u
i, A, @] Object —
|

......... dk Specify the 'period’ or ‘frequency’, and optionally the 'rise I
% .- at', 'fall at’ and 'jitter' values. ‘

Jitter (ns)

Constraints for Pulse Width Chedk Only

« reate_dodk -name dk [get_ports {dk}] Fall at: | ns  (optional)

C\ Object MName Frequency {MHz) Pel m k
| [& i Erequency: | ||MHz (required)
Constraints for Pulse gl Period: | | ns (required)
> R 1 | =
--------- Q Object J Rise at: | | ns (optional) [ [Eguency (MHz)  Pe
=5 Tel Command Preview (1) r& Existing Create Clock Constraints (0) ] % |

Jitter:

r O]

| ns (optional)

| [ Concel ]

- reate_dodk - |

<pack | Dext> | SkptoFmsh>> | [ Cancel |

[ <Back | Next> || SkptoFmsh> | [ cancel |

64



Clock Constraint Setting

- .. Timing Constraints Wzarr ' LB u

|| Primary Clocks

Primary clocks usually enter the design though input ports, Specify the period and optionally a name and
waveform (rising and falling edge times) to describe the duty cyde if not 50%%. More info

Recommended Constraints

C\ Ohject Mame Frequency (MHz) Period (ns) Rise At (ns) Fall At (ns) Jitter (ns)

gl &« x| woool _ woool o000 5ol |
/
T

Constraints for Pulse Width Check Only

C’K Object Mame Freguency (MHz) Perind (ns]
U
|
I e ¢ | i | =
% Tcl Command Preview (1) | £ Existing Create Clock Constraints (0) |
o« create_dodk -period 10,000 -name dk -waveform {0,000 5.000% [get_ports {dk}]
tive)
Project Summary X I@? Device X ]E.‘:i] Schematic IE.‘#] Schematic (2) = IE.‘#] Schematic (3) = IEIB todec X l
| < Back ]I Next = I[ Sk Fiish. ] [ - ] E:/Projects_FPGA/Proyecto_Clevis/Controlador ¥ fproject_1/project_1.srcsfconstrs_1fnew ft.xdc

1 create clock -period 10.000 -name clk -waveform {0.000 5.000]} [get ports clk]

E il gy controlador - Behavio ‘

[-{= Constraints (1)

: E}L'-j' constrs_1 (1)
L]t xcdc (target)

[+ Simulation Sources (1)

(Jj F—T— =

i i) of~ S

ICTP




Clock Network Report

l 4 Synthesis ] Clock Metworks - network_3
% Synthesis Settings E =M. dic (100,00 MHz) (drives 48 loads)
2 Run Synthesis = =0 dk
4[] synthesized Design 58 1 (ck_IBUF_inst/T)
%, Constraints Wizard =+l dk_IBUF_inst (TEUF)
=] E1-<@ O (dk_IBUF_inst/a)

{24 Edit Timing Constraints
ﬁ Set Up Debug

-

T = I dk_IBUF (clk_IBUF)

5
il
2

E B0 1 (ck_IBUF_BUFG_inst/T)

I (g Report Timing Summary a3 =il dk_IBUF_BUFG_inst (BUFG)
;. Report Clock Metworks E-4@ O {dk_IBUF_BUFG_inst/0)

B Report Clock Interaction = I dk_IBUF_BUFG (ck_IEUF_BUFG)
l (D ReportDRC [#1-15 FDCE (43 loads)

R t Moi
Ef Report Noise network 3 x|

R t Utilizati
B = Td Console L'D Messages LEQ Log L__=“| Reporth\""—p Clock Networks

4




Clock Network Report and Visualization

4 Implementation Clock Metworks - network_1
% Implementation Settings

m

[> Run Implementation
4 Implemented Design
,:_\., Constraints Wizard
£4 Edit Timing Constraints

. 2@ 1 (dk_IBUF_inst/T
=}-[ill dk_IBUF_inst (IEUF
B, 5@ O (ck_IBUF _inst/O)
I o[ dk_IBUF (ck_IBUF)
(< Report Timing Surmmar i LI dk_IBUF_BUFG_inst/
Iy, Report Clock Metworks [P

d

[=i] 0 nieracfnon - G 0 (dk IBUF BUFG inst/O

Report Clock Networks : i :

: o =1 I dk_IBUF _BUFG (ck_IEUF_BLFG
@ Rep Specify analysis options and create a clock networks report. J_ = - - - ’
ﬂ_lr;| Repaort Moise 4= FDCE {48 loads, -
| Report Utilization : network_1 X
£ Report Power = B Td Console | " Messages | [ Log | (2 Reports™, W Clock Networks

la

4

Q-

|;_ —

HI‘-% -

a3 v

i i
[
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@ O
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Clocking Resources: MMCM and PLL

Up to 24 CMTs per device
One MMCM and one PLL per CMT

Two software primitives (instantiation)
o * BASE has only the basic ports i coursnlB

CLEOUTE<30-

CLEROUTE<3:0= )8

CLKEBOUT,

CLKFBOUT

o * ADV provides access to all ports o Locken

PLL is primarily intended for use with the I/O phas
for high-speed memory controllers

The MMCM is the primary clock resource for user




Inference

Clock networks are represented by nets in your RTL design

° The mapping of an RTL net to a clock network is managed by using the appropriate clock
buffer to generate that net

Certain resources can be inferred

o A primary input net (with or without an IBUF instantiated) will be mapped to a global clock
if 1t drives the clock inputs of clocked resources

o The BUFG will be inferred

o BUFH drivers will be inferred whenever a global clock (driven by a BUFG) is required in a
clock region

o BUFHSs for each region required will be inferred

BUFIO, BUFR, and BUFMR cannot be inferred

o InstantiI?ting these buffers tells the tools that you want to use the corresponding clock
networks

PLLs and MMCMs cannot be inferred




Instantiation

All clocking resources can be directly instantiated in your RTL code
o Simulation models exist for all resources
o Refer to the Library Guide for HDL Designs
> Use the Language Templates ( %' ) tab

PLLs and MMCMs have many inputs and outputs, as well as many attributes
o Optimal dividers for obtaining the desired characteristics may be hard to derive

> The Clocking Wizard via the IP Catalog
o Only *_ADV available




Invoking Clocking Wizard

Click on the IP Catalog

Expand FPGA Features and Design > Clocking

Double-click on Clocking Wizar

The Clocking Wizard walks you
through the generation of
complete clocking subsystems

&1
MName AT
(+H= Automotive & Industrial
= AXT Infrastructure
[+~ BaselP
[+~ Basic Elements
[+ Communication & Networking
[+~ Debug & Verification
[#= Digital Signal Processing
[+ Embedded Processing
= FPGA Features and Design
=+ Clocking

- ~4F Clocking Wizard
T 10 Interfaces
[+ Soft Error Mitigation
& XADC
H-(= Math Functions
H-[= Memories & Storage Elements
H-[= Standard Bus Interfaces
H-= Video & Image Processing

| e Y e Y |

ICTP

Status License

Production Included




The Clocking Wizard: Clocking Options

Select Primitives to be used
© MMCMEZ_ADV witch to Defaults

© P LLE 2_A DV Component Name |c|k_wiz_{]

Clocking Options rOutput Clocks rMMCM Settings rPort Renaming rSummary

Primitive

Specify the primary input frequency and
source type

(@) MMCME2 ADV () PLLE2 ADV

. . . Clocking Features Jitter Optimization
> Optionally, select and specify secondary iNPU | e syireds 1 soread specram © s
Phase Alignment [] Minimize Power (7 Minimize Output Jitter

Select clocking features 7 oynanic Phase st [F] oynamic Reconhguraton || © Mndizs Tnput e fitring

> Frequency synthesis I Sofe Clock Startup
o Phase align ment Input Clock Information
Input Clock Input Frequency(MHz) Jitter Options Input Jitter Source
. . Primary 100.000 10.000 - 800.000 U1 * |0.010 Single ended clock capable pin
o
Dyn amic p h ases h Ift ["] | secondary 100.000 0.010 Single ended clock capable pin ¥

o




The Clocking Wizard: Output Clocks

* Select the desired number of
output clocks

* Set the desired output
frequencies

* Select optional ports

1F Customize IP

[ e = = =

Clocking Wizard (5.0)

[ Documentation | TP Location [3) Switch to Defaults

~ IPSymbd-

[] Show disabled ports

Component Name ‘c\kﬁoﬂre

Clocking Option;/output Clocks rMMCM Settings rPort Renaming rsummary }

The phase is calculated relative to the active input clock.

Enable Optional Inputs / Outputs

reset
locked

[ power_down

|| clkfbstopped

[ input_clk_stopped

Reset Type

Active High

iDutput Freq (MHz) Phase (degrees) Duty Cydle (%) : JUse
putput Clock D
pu Requested lActual Requested lActual Requested Actual rves Fine PS
clk_out1 100.000 [100.000 0.000 .000 50.000 50.0 BUFG v
m clk_out2 100.000 [100.000 0.000 .000 50.000 20.0 BUFG v
Dclk_out.i 100.000 0.000 50.000 BUFG v
clk_out4 100.000 0.000 50.000 BUFG v
clk_outs 100.000 0.000 50.000 BUFG b
clk_outé 100.000 0.000 50.000 BUFG v
ck_out7 100.000 0.000 50.000 BUFG v
USE CLOCK SEQUENCING ol s dhack
Source Signaling
Putput Clock Sequence Number _
Automatic Control On-Chip ingle-ended
1
i Automatic Control Off-Chip Differential
1 User-Controlled On-Chip
1 () user-Controlled Off-Chip
1
1
1




The Clocking Wizard: Port Renaming

Change input/output port names

Change optional port names

Clocking Options rDutput Clocks rMMEM Setting;/ Port Renaming rSummar',r

Input Clock
Input Clock  |Port Name  |Freq (MHz)  [Input Jitter (UT)
Primary clk_in1 100.000 0.010

Output Clock

VCO Freq = 1000.000 MHz

Output Clock Port Name Output Freq (MHz) Phase (degrees) Duty Cycle (%)
clk_outl clk_outl 100.000 0.000 a0.0
clk_out2 clk_out2 100.000 0.000 50.0

Optional Port Names

Dther Pins Port Name
reset reset
ocked locked




The Clocking Wizard: Summary

Shows the input, output frequencies

Other attributes depending on
the selections made

The Resource tab on the left provides
summary of type and number of
resources used

Clocking Options r{]utput Clocks rMMEM Settings rPurt F{enaming/mnmmw

Attribute Value
Input Clock (MHz) 100.000
Phase Shift MNone
Divide Counter 1

Mult Counter 10.000
ICLKOUTD Divider 10.000
CLKOUT1 Divider 10
ICLKOUT2 Divider OFF
ICLKOUT3 Divider OFF
CLKOUT4 Divider DFF
ICLKOUTS Divider OFF
CLKOUT® Divider OFF

/P S'IfFI"Ith/FlEﬁﬂlII'EE

1 MMCME2
1 IBUFG
3 BUFG




Reset and Clock Topology



Enabling Clock for PL

processing_system7_1

. g: Re-customize [P —“ ----- u

ooR
- FIXED_IO-h Il
Maa_ero_aak ZyINCY "-‘;Lm 55 ZYNQ7 Processing System (5.5) '
FCLK_RESETO_N

Iffi! Documentation 4F% Presets [ IP Location £} Import XPS Settings

ZVNQT Processing System

Page Mavigator << | | Clock Configuration Surnmary Report
|| Zyng Block Design Basic Clocking | Advanced Clocking |
|
||| Ps-PL Configuration 4= InputFrequency (MHz) 33.333333 | CPU Clock Ratio) 6:2:1 v |
(. | |
Peripheral I/ Fins = Search: |Q~r |
I (5]
MIC Configuration % Component Clock Source Requested Freguen...  Actual Frequency(M... Range{MHz)

| »

I |Ci k Configueationa: E‘EE' Processor/Memory Clocks
3 - 10 Peripheral Clocks

|| | COR Configuration  |* &) PL Fabric Clocks
' : |10PLL M |s0.000000 0.100000 : 250.000000 I
SMC Timing Calculatio : |
: FCLK_CLK1 10PLL 50 50.000000 0.100000 : 250.000000 = | |
Interrupts - [[] FCLK_CLK2 10 PLL 50 50.000000 0. 100000 : 250.000000 '
~ [[] FCLK_CLK3 10PLL 50 50.000000 0.100000 : 250.000000
[+~ System Debug Clodks L
[+~ Timers -

1| 1] | b




g: Re-customize IP l"\f

ZYNQ7 Processing System (5.5)

W Documentation ﬁ. Presets B IP Location ﬁ Import ¥P5 Settings

Page Mavigator < | | PS-PL Configuration

Summary Report

[+ Address Editor
[+ Enable Clock Triggers

FCLK_RESET2_N
" ...FCLK_RESET3_N

Zyng Block Design
¥na . + Search: | Q-
P5-PL Configuration
=4 | Mame Select
(=55
Peripheral IjQ Pins e | [E- General
_ ¥ | L-UARTD Baud Rate 115200
MIO Configuration - UART1Baud Rate 115200
Clock Configuration ~PL AXTidle Port (]
--DDR. ARE bypass Port [l
DOR Configuration - PS-PL Debug interface F
SMC Timing Calculation —FTM Trace data interface [
~FTM Trace buffer ]
Interrupts -FTM Data edge detector 0
~FTM Trace buffer FIFO size 128
-FTM Trace buffer dock delay 12
—Indude ACP transaction checker 0
~Trace datafcontrol signal pipeline width 3
- Power-on reset(POR) 4k timer O
- Processor event interface O

FCLK_RESETO_N

o

g

Description

[ »

Baud rate is generated with internally fixed UART Ref Clod
Baud rate is generated with internally fixed UART Ref Clod

Enables idle AXI signal to the PS5 used to indicate that there
Enables DOR. urgentfarb signal used to signal a critical mem
Enables PL debug signals to PS and vice-versa

Enables FTM Trace AXI stream interface used to capture d;
Generates a FIFO to hold trace data

Stores trace data in the FIFD when the data changes as m
FTM Trace buffer FIFO size

Mumber of dock cydes interval for a trace data output fror
Enables ACP transaction checdker.

Enables configurable number of pipeline stages on the TRA
Enables power-on reset(POR) 4k timer, By default, 64k tim

m

Enables event bus which provides a low-atency and direct

ables general purpose reset signa r PL logic
Enables general purpose reset signal 2 for PL logic

Enables general purpose reset signal 3 for PL logic




SDK Compilers



GNU Tools: GCC

GCC also functions as the user interface, passing options to- t:ﬁlj_
GNU assembler and to the GNU linker, calling the assembler
<file>.c ﬂ

GCC translates C source code into assembly language . H

and the linker with the appropriate parameters

Supported cross-compilers [ Cross-Compiler ]

ARM processor compiler
> GNU GCC (arm-xilinx-eabi-gcc)
> GNU Linux GCC (arm-xilinx-linux-eabi-gcc)

<file>.s




GNU Tools: AS

Input: assembly language files <file>.s
° File extension: .s

Output: object code
o File extension: .o

Contains ﬂ

> Assembled piece of code
Cross-Assembler

o Constant data
o External references
> Debugging information

Typically, the compiler automatically calls the assembler

Use the -Wa switch if the source files are assembly only and

use 2CcC
5 <file>.0




GNU Tools: Linker (LD)

Inputs <file>.0  <project>LinkScr.ld
> Several object files

o Archived object files (library)
o Linker script (*./d)

Linker
script

Outputs B U
o Executable image (ELF) [ Linker/Locator ]
> Map file

Executable

executable.elf




Timing Reports



Report Timing Summary

|4 Synthesis
5 Synthesis Settings

Tcl command: report_timing_summary

@ Run Synthesis
4 Synthesized Design
£4 Edit Timing Constraints
| @ Report Timing Summan,r|
. Report Clock Networks

report_timing_summary -delay_type max -report_unconstrained -check_timing_verbose -max_paths 10 -input_pins -name timing_1

Vivado IDE

Options tab
> Maximum number of paths

Advanced tab
o Write to a file

Timer Settings

° Interconnect delay can be igno

o Flight delays can be disabled

gptioryf Advanced rIimer Settings ]

Fins
Show input pins in path

File Output
[ ] wirite results to file:

(@) Overwrite Append
Miscellaneous
[ | 1gnore command errors (quiet mode)

[] suspend message limits during command execution

Options rﬁdgancep/ Timer Settings

Interconnect: estimated
Speed grade: -1 (default) -
Multi-Corner Configuration
Carner name Delay type
Slow min_max ~
Fast min_max -

[ ] Disable flight delays

4. Report Timing Sum

——,

@ Generate a timing summary to understand if the design met timing.

Results name: |timing_1

Options ]’Adganced rIimer Settings

Report
Path delay type: | max -

Report unconstrained paths

|| Report datasheet

Path Lirmnits
Maximum number of paths per clock or path group: 1005
Maximum number of worst paths per endpoint: 15
Path Display
Display paths with slack less than: Use default (1e+30)
Significant digits: l=




Report Timing Summary

Design Timing Summary

----- |31 Timer Settings Setup Hold Pulse Width
© W N S, TN S, tOta I n U m be r [2 Design Timing Summary | worst Megative Slack (WNS): 1.826 ns  Waorst Hold Slack (WHS): MA  Worst Pulse Width Slack (WPWS): 3.000 ns

----- =1 Clock Summary (3]

I [ Check Timing (45) Total Negative Slack (TNS):  0.000 ns  Total Hold Slack (THS): NA  Total Pulse Width Negative Slack (TPWS): 0.000 ns
Of e n d po I ntS a re Of [ Intra-Clock Paths Mumber of Failing Endpoints: 0 Number of Failing Endpoints: NA  Number of Failing Endpoints: .
i @ Inter-Clock Paths Total Number of Endpoints: 102 Total Number of Endpoints:  MA ~ Total Number of Endpoints: 45
I nte re St = Path Groups

----- |2 User Ignored Paths T

-2 Timer Settings
. o

: Design Timing Summary i MName Waveform Period (ns)  Frequency (MHz)
C I OC k S u m m a r -2 Clock Summary (3) | =5 |Eclkin {0.000 5.000} 10.000 100.000
EHE Check Timing (45) 2| -k outl_clk_SMHz {0.000 100.000} 200.000 5.000
"Ti" Intra-Clock Paths “ clkfbout_clk_SMHz {0.000 25.000} 50.000 20.000
- M D Inter-Clock Paths
> Primary and derived clocks &c e aoms N
-[&1 User Ignored Paths Check Timing
~ 1
a Timing Check Count

----- |2 Timer Settings

c h ec k Ti m i n ..... % Design Timing Summary unconstrained_internal_endpoints 26
g no_clock 10

----- 12 Clock Summary (3)

= Check Timing (45) | ﬂo_éutptutadlelav g

M = no_input_delay
o Number of unconstrained oreogi: e dock 0
. . [F0 Path Groups generated_clocks 0
..... = loops 0
internal endpoints 3 User Ignored Paths ol input_deley 0
partial_output_delay 0




